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How To Create The Life Of Y‘!ﬂi_@

You Are Currently Using A Limited Version Of The
Dream Life Creator, Which Provides Only The First
12 Steps Of The Dream Life Creation Process!

The entire Dream Life package, which can be obtained from:
www.DreamL ifeGuide.com contains the following tools and products:

* The Dream Life Manual: A step-by-step guide that takes you by the hand and leads you
in simple and easy to follow steps to the life of your dreams.

* The Dream Life Action Manual: This is your roadmap, your step-by-step plan towards
the life of your dreams.

* The Dream Life Audio Files: Listen to groundbreaking ideas and techniques on your way
to work, in the train, during a relaxing walk in the park... whenever and wherever you want.
You get immediate access to a total of 29 audio files (about 4 hours of recording) packed
with great guidelines, tips and ideas on how to create the life of your dreams!

* The Dream Life Software: The software guides you step-by-step through the entire
Dream Life Creation process. You decide how fast you want to move on and this amazing
tool literally takes you by the hand and guides you from one step to the next... towards the
life of your dreams.

Go to www.DreamL.ifeGuide.com to find
out more about the Dream Life Package!
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1 Dream Life Creator Installation Instructions

To start the installation process, double-click the file: DreamLifeCreatorSetup.msi

If you are using a computer with Windows Vista, the following screen might be

displayed:

Don't run the program unless you know where it's from or you've used it

brefare.
EE' Unidentified Pulslisher
< Cancel

I den't know where this program is from or what it's for.

< Allow

I trust this program, | knogfwhere it's from or Dve used it before, [:%‘

() Details

User Account Control helps stop unauthorized changes to your computer.

Fig. 1.1: Windows Vista User Account Control

Simply click "Allow I trust this program. | know where it's from or I've used it

before."
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Then you will see the following screen (this is the first screen you will see on a
computer with Windows XP, Windows 2000, Windows 98...):

.-.! ]
it Dream Life Creator

Welcome to the Dream Life Creator Setup Wizard

The inztaller will guide you through the steps required to install the Dream Life Creator Software on
Vaur computer.

WARMIMNG: Thiz computer program iz protected by copyright law and international treaties.
IInauthorized duplication or distribution of this program, or any portion of it, may result in severe civil
ar criminal penaltiez, and will be prozecuted to the masimum extent poszible under the law.

Fig. 1.2: Welcome Screen

Click the "Next" button at the bottom right of the screen.
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Now, the License Agreement Screen will be displayed:

i'-.% Dream Life Creator

License Agreement

Pleaze take a moment ko read the licenze agreement now, If you accept the terms below, click '
Agree', then "Mext". Otherwize click "Cancel”.

Dream Life Creator
Copyright (C) Robert Spadinger. All Rights Reserved.

[

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT
WARRANTY OF ANY KIND, EXPFRESS OR IMFPLIED, 0
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURTOSE AND NONINFRINGEMENT. IN NO EVENT v

()| Do Mot Agree & | Agree

[ Cancel ] [ ¢ Back ] [ Mext »

Fig. 1.3: License Agreement Screen

Select "I Agree" and click the "Next™" button.
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On the following screen you have to choose the installation folder. | recommend you
leave the default installation folder and click the "Next" button.

i'-.%‘ Dream Life Creator

Select Installation Folder

T he ingtaller will install Dream Life Creatar to the following folder.

Toinztall in this folder, click "Mext". Taoinztall to a different folder, enter it below or click “'Browse'".

Eolder:
C:AProgram FilezhDLCreatarh [ Browsze. . ]
|  Diskcost. |
Cancel ] [ ¢ Back ] [ M et »

Fig. 1.4: Select Installation Folder

Page 7

© Robert Spadinger — All Rights Reserved www.DreamL ifeGuide.com




On the next screen you need to confirm that you want to install the Dream Life
Creator Software. Again, click the "Next" button.

i'-.%" Dream Life Creator

Confirm Installation

The ingtaller iz ready to inztall Dream Life Creator on pour computer.

Click. "Mext" ta start the installation.

Cancel ] [ ¢ Back ] [ Mext = J

Fig. 1.5: Confirm Installation
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ii# Dream Life Creator

Installing Dream Life Creator

Diream Life Creator iz being inztalled.

Fleaze wait...

Fig. 1.6: Installation Progress
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And finally you will see the following screen:

4 4
it Dream Life Creator

Installation Complete

Diream Life Creator has been successfully installed.

Click "Cloze" o exit.

Cancel < Back

Fig. 1.7: Installation Complete Screen

Click the "Close" button to finish the installation process.
1.1 Starting the Dream Life Creator Software
Now you can start the Dream Life Creator Software by double-clicking on the icon

labeled "Dream Life Creator™” which was added to your Desktop.

You can also start the application by clicking on the Windows XP Start button, then
select All Programs -> Dream Life Creator -> Dream Life Creator.
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2 Dream Life Creator User Manual

2.1 Introduction

The Dream Life Creator Software is a fantastic tool that guides you step-by-step
through the entire dream life creation process. You move from one step to the next —
in the correct order -, you read the detailed information provided with each step, you
do the exercises and make a note of your own realizations and ideas.

You can use the Dream Life Creator Software in two different modes: The guided
mode and the manual mode.

The guided mode guide you step-by-step in the correct order through the entire dream
life creation process and I highly recommend you get started with this mode.

The manual mode allows you to access the various dream life creation steps in an
arbitrary order. You can use it after you did the entire dream life process at least once
(using the guided mode) to re-do certain exercises or to add new insights and ideas to
various steps.
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2.2 Dream Life Creation — Guided Mode

You can use the dream life creator software in 2 different modes: In manual- or
guided mode. The guided mode guides you step-by-step through the entire dream life
creation process, whereas the manual mode allows you to access the various steps in
an arbitrary order.

I highly recommend, you use only the guided mode at the beginning to move one step
after the other through the dream life creation process. The manual mode is interesting
to go back to specific steps once you are finished with the entire process. You can use
the manual mode to add additional notes and information or to certain steps, to re-do
certain exercises.

The screenshot below shows the window that is displayed after starting the dream Life
Creator. By default you are starting with the guided mode.

Dream Life Creator

{4 Guided 2% Manual | @ Help 1 About
Current Step: Today Begins The Journey To The Life Of Your Dreams - Leave The Past Behind And Step Into & MNew World
Exercise: Mo specific exercise is required for this step
Times Mew Roman + 3 = B I U |A #|@& EE == iz = EE
Mo specific exercise 1z required for this step, but you can make some notes of your own ideas and realizations...
You are currently at step 2 of 29

Fig. 1: Guided Mode

Elements of the guided mode window:

e Toolbar: At the top of the window you can see the dream life creator toolbar
that allows you to change between guided mode and manual mode, to display
the instruction manual and the "About" window.

e Current Step: Here you can see the title of the current step. Sometimes, the
title of the current step might be too long to be completely displayed here, but
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when you hover with your mouse pointer over the displayed text, a small
tooltip window appears in which the entire step title is displayed. These
tooltips appear also over buttons to display additional information.

e Show Button: When you click the button "Show" next to the step title, the
entire description of the current step is displayed in a separate window.

e Exercise: Next to the "Exercise" label you can find a short description of the
exercise that needs to be performed. Again, when you hover with your mouse
pointer over the displayed text, a small tooltip window appears in which the
entire exercise description is displayed. Not all steps require a specific
exercise to be performed.

e Exercise — Notes Window: Just below the exercise description you find an
editor that allows you to add your own notes and ideas to the current dream
life creation step or to perform a specific exercise. A detailed description of
the editor can be found further down.

e Save Button: This button allows you to save the modifications you made in
the exercise-notes window.

e View: Clicking this button allows you to display and edit the content in the
exercise-notes window in a separate window. This allows you to edit and view
your content in a more practical re-sizeable window (see image below).

‘E_g Dream Life Creatol @
i 4 Guided ¥ Manual | @)Help 1 About
current step: Today Begins The Joumney To The Life Of Your Dreams - Leave The Past Behind And Step Into A ew World
: 55 Your Notes For The Current Step
File | Edit | ¥iew Insert
Ti
rmesn| J e B 7 U|A#|@ === |
I T 2 .
1o g T gL Bt g s o o1 can malkce some notes of your own ideas and realizations..
Copy
Select All
Find
You are currently at step 2 of 29

Fig. 2: Separate Exercise — Notes Window that can be re-sized to any desired size
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e Next Step Button: This button allows you to move on to the next step once
you are finished with the current one. Use this button only once you are
finished with the current step, because in the guided mode you can't go back to
the previous step unless you start all over.

e Restart: Clicking this button allows you to start all over (with step 1) with the
dream life creation process. To deeply integrate all the ideas and dream life
creation principles, it's a good idea to do the entire dream life creation process
several times. The information you provided in the exercise-notes window for
the various dream life creation steps is not deleted and there is no need to
completely "restart at zero", but you can always add some additional ideas,
realizations....

e Statusbar: At the bottom of the window you can see the step number you are
currently working with and the total number of steps.
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2.3 Display Details For Each Dream Life Creation Step

As already explained in the previous chapter, when you click the "Show" button, a

separate window is opened that displays the content of the current dream life creation

step.

When you right click with your mouse on the right side of the editor toolbar, a small

context

menu appears that allows you to print the content of the window — see

screenshot below.

Modifications made to the content in this window cannot be saved.

Gurren

Detailed Description Of The Current Step

ac a[BlzulACle |E ]

Step 2: Today Begins The Journey To The Life Of Your Dreams - Leave The Past Behind

Exercis|

Times Me

Mo spd

Savel

And Step Into A New World

The creation of your dream life starts right here and right now, exactly at this point where you are currently standing m your life. This is your departure
pomnt and it defines the route towards your dream life.

Ifyou don't have a starting point, you won't be able to pick the roads that lead vou to the bfe of vour dreams, to a ife that's filled with love,
abundance, happiness, freedom

o, first you need to become aware of who you are right now. What are your predommant thoughts and feeling throughout the day? Are they rather
positive or negative? What are your inner beliefs and convictions?

Do you think you are strong, intelligent, wealc, a failure, motivated, happy. mostly sad...? What are your desires? What are your goals? Do you think
you will reach them one day? What are you yearnng for? What 13 tnissing i your hfe? .

Dig inte your bfe, look at your current circumstances and become aware of all the things you like about yourself and your ife and about all the things
you don't like so much

These questions will help you to get a better idea of where you are standing currently. Be honest with yourself and try to answer them as good as you
can. Whatever answers you may find, don't judge yourself and don't let thetn make you sad or frustrated.

Mo matter where you are standing at the mement, you have the power to create the most amaring life you can imagine and as you will see i the
coming chapters, it's not even that difficult. Soon you will learn how to make use of the almighty power that lies within you
To get the most out of this first step towards realizing your dream life, you should pay attention to the following recommendations:

Above all, be honest with yourself If'there is something in your life you den't like so much, something that causes you sleepless nights or something
that makes you sad, desperate or frustrated, then bring it up. Don't try to suppress it or to run away from it

Fig. 2: Detailed description for the current step
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2.4 The Editor — Providing Notes, Ideas... For Each Step

We already briefly discussed the "Exercise — Notes Editor" in one of the previous

chapters. Here is a more detailed description of this editor.

The "Exercise — Notes Editor" allows you to add your own realizations, ideas, notes...
and of course exercises (if they are required) in a nicely formatted way to each step of

the dream life creation process.

Dream Life Creator

i Guided % Manual | €@)Help 1T About
Current Step: Today Begins The Journey To The Life Of Tour Dreams - Leave The Past Behind And Step Into 4 New World
Exercise: No specific exercise is required for this step
- - & === = |iT = iE = 1
Times Mew Roman 3 |B £ O ‘é \% = = = = iz = £ = | Fie q
) S ) Edit r Undo
IRt e e rcise is required for this step, but you can make some RS R gl Rl LR T By=F:1iketale
Wiew 3 Redo
Insert 3 ot
Copy
Paste
Select Al
Find
You are currently at step 2 of 29

Fig. 3: Exercise — Notes editor
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2.5 The Editor Toolbar

The editor toolbar provides a simple and intuitive way to format your text and to make
it look nicely.

Below is a short description of the different toolbar elements (from left to right —
see image below):

Tirnes Mew Roman - 3 - | B F U |A £ |@& |

b

Il
11
ok
i
(]
i

Fig. 4: Editor Toolbar
To apply a specific option (font type, background color...), select the entire text in the
window or only a part of it and click the appropriate button in the editor toolbar.

Font Type: the drop down box at the very left of the editor toolbar allows you to
choose from various different font types.

Font Size: Allows you to select your font size.

B: Make your text bold.

I: Make your text Italic

U: Underline your text.

Text Color: Choose the color of your text.

Background Color: Choose the background color of your text.
Link: Allows you to insert a hypertext link.

Text Align: You can choose between left align, center, right align and justified.
Numeration: Create a numerated list.

Bullet list: Create a bullet list.

Outdent: Outdent a specific paragraph.

Indent: Indent a specific paragraph.
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2.6 The Editor Menu

You can access the editor context menu by right clicking the empty area next to the
editor toolbar. The editor context menu allows you to perform basic file operations,
such as saving a modified file, printing, basic edit operations...

Below is a screenshot of the editor context menu, displaying the available ""File"
operations:

= File 3 Save
Edit » Print.
Insert 3 | I

Fig. 5: Editor Context Menu - File
Save: Allows to save the (modified) content in the editor window.

Print: To print the content in the editor window.

Below is a screenshot of the editor context menu, displaying the available "Edit™
operations:

= File 3

| Edit , | Tl
Insert ] Fedo

Cuk

Copy

Paste

Select Al

Find

Fig. 6: Editor Context Menu - Edit

Undo: Undo the last operation (text formatting, deletion of text...). For example, if
you accidentally deleted some text, you can un-do this operation by clicking
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Edit > Undo

Redo: Redo the last operation after an "Undo™ was performed.
Cut: Allows you to cut out the selected text.

Copy: Allows you to copy the selected text.

Paste: Paste a previously cut-out or copied text

Select All: select the entire text in the editor window.

Find: Find a specific word or phrase in the text that is displayed in the editor window.

Below is a screenshot of the editor context menu, displaying the available
"Insert" operations:

i File » k—J ‘ ‘

Edit b

Insert k Ereak

HTML

Fig. 8: Editor Context Menu - Insert

Break: This command allows to draw a horizontal line across the page.

HTML.: This command allows to insert HTML code into the page or to simply get the
HTML code of the current page. When you click Insert > HTML, a popup window is
displayed that shows the HTML code of the current page. Now you can either copy
the entire HTML code and do something else with it (for example paste it into a web
page) or you can replace the HTML code with HTML code from a different source
(for example with the HTML code from a web page).
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2.7 The Dream Life Creator toolbar

The main toolbar at the top of the window allows you to switch between the guided
mode and the manual mode and to display the user instruction manual as well as the
"About" page.

4 Guided 2% Manual | @) Help - About
Fig. 10: Dream Life Creator Toolbar
Guided: Click this button to use the guided mode for the dream life creation process.
This is the default mode.
Manual: Click this button to use the manual mode for the dream life creation process.
Help: Click this button to display the instruction manual

About: Displays the About window of the Dream Life Creator.

2.8 Dream Life Creation — Manual Mode

The manual mode allows you to access the various steps of the dream life creation
process in an arbitrary order. As | already mentioned, you should use this mode only
once you completed the entire process at least once in the guided mode.

The manual mode however is very practical, because it allows you to immediately
access any of the dream life steps and to add additional ideas, realizations... to re-do
certain exercises or to simply recall certain steps of the dream life creation process.

Below is a screenshot of the manual mode window:

Most of the elements that | explained in the "guided mode" section (exercise-notes
editor...) are also valid for the manual mode.

However, in the manual mode you can also see a list of all the dream life creation
steps on the left side of the window. When you hover with your mouse pointer over a
certain step title, a small popup window is displayed that shows the entire step title.

At the very left you can also see a small icon that indicates whether you already
provided input (ideas, notes, exercise...) for a certain step.
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U : No input has been provided so far for this step.
lw : You already provided some input for this step.

When you click on a specific step title in the list, the entire window is
automatically updated with the information that corresponds with the currently
selected step:

e The step title is displayed at the top of the window.

e When you click the "Show" button at the top of the window, the detailed
description for this step is displayed in a separate window

e The exercise description is updated (if a specific exercise needs to be done).

e The exercise - notes window is updated with the content you already provided
for this step (if you provided any content).

¢ And the status bar at the bottom of the window is updated with the current step
number.

Dream Life Creator

5 Guided  ©% Manual | @)Help M About

Current Step:  Become Crystal Clear About What Your Dream Life Should Look Like - Be Bold And Daring And Choose -
‘Whatever You Want
List of Steps: Exercise: Mo specific exercise 15 required for this step
Step Name ‘_‘! Times Mew Roman - 3 -|B I U |éi|% | = = = = |z i= £ J

18 The Biggest Adventure Of Your Li |

%" Today Begi :
# Tadoy PEONS [ b ome Crystal Clear About What Your Dream Life Should Look Like - Be Bold And Daring And Choose Whakever You Want ]C'fyour own ideas and
¥ Your Biggest I

[ 4 Become Crystal Liear About What

# You Are Unhappy. You Don't Like.
[ Energize Your Dream Life Yision A

[ A Crystal Clear Vision Of Your Dre
[ A Simple Way To Energize Your D —
{4 Stop Pushing And Hurting - There.
{3 A Simple Exercise To Help You M.
[ Power Visuals - Another Great To
[ Tuming Hard Work Into Play And

[J Step By Step Towards The Life O1
[ You Are Not Alone On Your Path -
[7A Little Secret That Allows You T.
{4 How You Can Make Sure That Yo %
< |

You are currently at step 4 of 29

Fig. 11: Dream Life Creator Manual Mode
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